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1. Le prototypage rapide :

 1.1 Contexte

 Le prototypage rapide est une méthode permettant la réalisation physique de modèles 
numériques élaborés sur des logiciels de CAO tels que SketchUp, Rhinoceros, AutoCAD 3D etc.

 Les procédés de déformation, soustraction et addition sont variées, ce sont cependant 
les techniques d’impression 3D, d’usinage très grande vitesse, de découpe laser et de stéréo-li-
thographie qui sont le plus accessibles aujourd’hui. Les domaines d’exploitation sont très variés 
et couvrent les univers de l’art, du design, de l’architecture, de la mode, de la bijouterie, de l’aé-
ronautique, ainsi que de la santé.

 1.2 En architecture

 Au cours des étapes d’avant projet, le concept n’est pas encore précis et de nombreux 
essais de création et de modélisation sont habituellement nécessaires avant d’arriver aux étapes 
ultérieures. Ces concepts sont traduits, depuis le dessin en deux dimensions, à une modélisation 
en trois dimensions, et usuellement à échelle réduite, pour permettre une meilleure approche 
et une meilleure compréhension du projet. La maquette d’étude classique est largement utilisée 

Un rein imprimé en 3D ( Wake Forest Baptist Medical Center www.theatlantic.com )
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mais nécessite d’y consacrer du temps qui peut s’avérer précieux lors de la conception. De nom-
breux logiciels permettent de maquetter virtuellement de façon simple, rapide, et permettent aux 
architectes et étudiants de tenter de percevoir les volumes que représentent leurs tracés sans 
avoir à réaliser une maquette d’étude qui prendrait plus de temps à façonner.

 Cependant la perception virtuelle d’éléments destinés à exister réellement est souvent 
biaisée par les effets de focale de ces logiciels, et par la taille du moniteur sur lesquels ils sont 
affichés. La manipulation est plus difficile et l’utilisateur nécessite souvent un temps supplémen-
taire pour apporter des modifications au modèle. La maquette réelle est plus maniable, plus 
souple, et l’apport de changements est plus aisé de cette façon. Les techniques de prototypage 
rapide semblent apporter une solution à l’écart existant entre la maquette réelle et virtuelle. Elles 
permettent en effet d’obtenir un modèle en trois dimensions à partir d’une une modélisation en 
3D, quelle que soit sa complexité.

 1.3 Caractéristiques

 Les méthodes de prototypage rapide qui se popularisent et deviennent abordables pour 
les professionnels et particuliers peuvent entrer dans ce processus de conception. Précisément, 
pour l’architecte ces outils possèdent des caractéristiques idéales pour répondre à la question de 
la gestion du temps lors des phases d’avant projet. Les outils de prototypage rapide possèdent 
des caractéristiques de production variables selon la technique utilisée, mais ils répondent ce-
pendant tous fondamentalement à trois principes. 

Parametric Sculpture par Matt Compeau en modélisation virtuelle et imprimée en 3D au CRAI
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 Ils permettent par leur rapidité d’exécution de créer des modèles physiques de plusieurs 
étapes d’un projet et jouent en la faveur de la réduction de leur temps de développement. Ceci 
peut s’avérer crucial chez l’architecte, pour qui un gain de temps de production de maquette 
permet de se concentrer sur le concept même. De plus, le principal coût des machines permet-
tant le prototypage rapide est celui de leur acquisition, les matériaux utilisés sont abordables et 
garantissent un très bon rapport qualité / prix. Enfin, le prototypage rapide permet d’obtenir des 
formes complexes de façon assez simple ( sphères creuses etc. ).

 1.4 Etude

 Pour la fiabilité de cette étude, nous nous sommes concentrés sur la technique d’im-
pression en 3D par ajout de matière, à laquelle a été mise en comparaison la technique de 
découpe laser. Ce choix a été porté par le fait que le CRAI possède une imprimante 3D et l’école 
d’architecture une machine de découpe laser.

 L’impression en 3D et la découpe laser sont les méthodes les plus faciles d’accès, finan-
cièrement, et pour des questions de prise en main. Ce sont ces outils qui équipent de plus en 
plus les universités, les centres de recherche, les laboratoires de fabrication ( FabLab ) ainsi que 
les particuliers. Les atouts en matière de vitesse, de coût et de complexité annoncés par le pro-
ducteur de ces outils sont certains, mais la question est de fiabiliser son application au domaine 
de l’architecture et plus précisément à la maquette d’avant projet.

2. L’impression 3D

 2.1 Matériel

 L’outil Makerbot Replicator 2 dont dispose le centre de recherche produit des modèles 
3D par “Fused Deposition Modeling”. Le FDM consiste en la dépose de couches successives 
et fines ( 0.2 mm ) de thermoplastiques de type ABS ou PLA. La matière plastique utilisée par 
la machine se présente sous la forme d’une bobine d’un kilogramme de fil plastique valant une 
trentaine d’euros pièce. Ce plastique chauffé à 230°C prend forme d’un fil liquide et est déposé 
en couches successives par une buse d’extrusion se déplaçant sur trois axes. Les modèles de 
machines opérant ce type de technique existent en très grand nombre, les plus répandus étant 
les outils de la société MakerBot.

 2.3 Expérimentation

 Cette machine a une production constante au CRAI et produit des modèles quasi conti-
nuellement, jour et nuit. Les objets imprimés varient du modèle de maquette d’étude, au rendu, 
et sont produits principalement pour les études du centre de recherche. Afin d’avoir de la matière 
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pour mener cette étude, nous avons mis à disposition le service d’impression à un groupe d’étu-
diants en cinquième année préparant leur projet de fin d’étude. Le service d’impression ne signi-
fie cependant pas l’accès pur et simple à la machine mais la récolte des fichiers de modélisation 
destinés à être imprimés. La philosophie de cette expérimentation a été « Fournissez nous vos 
documents à imprimer dans leur état brut ». Cela implique de recevoir des fichiers venant de 
différents logiciels, avec un niveau de détail et de complexité variés, qui ont permis d’avoir un 
large champ d’approche quant à la faisabilité des modèles.

 2.4 Processus, slicing

 Un modèle numérique en trois dimensions, afin d’être imprimé en trois dimensions, 
doit être découpé en fines couches 2D par l’un des logiciels spécifiques appelés slicers. Ces 
logiciels, tels que MakerWare, Skeinforge, ou encore Slic3r, interprêtent les volumes en trois 
dimensions d’un fichier de modélisation 3D, et les découpent en fines tranches ( généralement 
0.2 mm ). Ces couches de plastique déposées les unes sur les autres forment ainsi petit à petit 
le modèle 3D désiré. Le slicer crée un fichier gcode qui permet la commande de l’imprimante 
3D. Ce code donne les positions successives dans l’espace que la buse d’impression doit suivre, 
ainsi que des instructions sur la vitesse d’extrusion du PLA, la vitesse de déplacement, le taux 
de remplissage des volumes fermés, la température de chauffe, etc.

 Pour que cette opération se déroule bien il faut cependant que les volumes soient fer-
més, ou “étanches”. Cela signifie que si l’on s’imagine ce volume réel plongé dans l’eau, elle ne 

Le modèle Makerbot Replicator 2 utilisé lors de cette étude. ( www.makerbot.com )
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doit pas pouvoir pénétrer à l’intérieur. Cela peut poser problème dans certains logiciels comme 
SketchUp où les erreurs d’étanchéité des modèles sont fréquentes et de plus difficiles à repérer. 
D’autres comme Rhinoceros sont dotés de commandes permettant de boucher les trous plans, 
ce qui permet de résoudre une partie de ces erreurs.

 Si un modèle n’est pas entièrement étanche, les slicers interprêtent généralement mal 
la géométrie du fichier et génèrent un code d’instruction à la machine qui est erroné, et qui en-
traine une impression non fidèle à la modélisation première. Il existe par ailleurs des logiciels qui 
génèrent une visualisation du gcode et qui permettent de repérer des éventuelles corruptions 
de la géométrie du fichier ( c’est le cas de l’application internet gcode.ws ; ainsi que le logiciel 
MakerWare qui comprend un visualisateur de gcode disponible lors de la phase d’exportation.

Un modèle 3D bombé non étanche contenant des erreurs, visibles dans MakerWare

Le site gcode.ws montre le chemin erroné indiqué par le gcode à la machine.
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3. Fiabilité

 3.1 Méthode

 La question première lorsque l’on réfléchit sur la fiabilité et la pertinence de l’utilisation 
du prototypage rapide en architecture est de permettre à ces technologies d’aider l’architecte et 
non de le freiner. Les modèles 3D des étudiants qui ont été recueillis pour cette étude montraient 
que suivant le logiciel utilisé, la complexité des modèles, et leurs formes, étaient un frein à la 
technique d’impression 3D. Leur modélisation brute et non préparée empêchait ou rendait diffi-
cile l’impression ou impliquaient des optimisations de fichiers 3D importantes.

 Après une première observation, il a été observé que certains modèles, tracés en deux 
dimensions, ou dont la forme en trois dimensions est décomposable en éléments en 2D étaient 
beaucoup plus propices à être découpés par la machine laser plutôt qu’imprimés, pour des rai-
sons de temps, de complexité de modélisation ( la découpe laser ne nécessite que des tracés 
vectoriels 2D ). L’élément décisif afin que les techniques de prototypage rapide révèlent au 
mieux leur vitesse se situe lors de la phase d’avant projet. Le choix en amont de la technique 
de prototypage est déterminant pour empêcher les opérations de réparations ou d’adaptation 
successives des fichiers CAO très gourmandes en temps.

 Il est important de pouvoir comprendre rapidement quelle technique est la plus appro-
priée à tel ou tel type de modèle. Il serait inutile de modéliser en trois dimensions des surfaces 
planes destinées à être imprimées en 3D, sauf par exemple si leur épaisseur est trop importante 
pour la machine de découpe laser, ou si ces surfaces planes comportent des bords biseautés, ou 
complexes, ne pouvant pas être réalisés par découpe. Certaines formes sont aussi plus faciles à 
réaliser par maquettage traditionnel en utilisant des matériaux appropriés ( carton ondulé, etc. ).

 3.2 Exemples

Cette surface plane est très simple à réaliser par maquettage traditionnel ou par 
découpe laser. L’imprimer en 3D serait moins productif.
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Cet objet a une trop grande épaisseur pour être découpé au laser, le maquettage 
ou l’impression 3D seraient une solution, à moins qu’on le décompose pour le 
rendre réalisable par découpe :

2

3

4
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Les images 4, 5 et 6 montrent des objets ayant des bords biseautés, complexes, 
ou arrondis qui ne peuvent pas être obtenus par découpe laser. Les géométries 
des images 7 et 8 sont quant à elles simples à obtenir par découpe.
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Décomposer un volume en éléments plans permet d’utiliser plutôt la machine 
de découpe laser ( 9, 10, 11 ).

10

11

12

13



13

12 et 13 présentent un modèle décomposable, afin d’utiliser les deux techniques, 
d’impression et de découpe, pour une meilleure productivité. 14 est quant à lui 
complexe et et difficile à imprimer à cause des parties non accessibles.

Imaginons que l’on veuille réaliser une maquette au 1/10e d’une partie du patio 
de l’ENSA Nancy. Il convient de réaliser un modèle décomposable, ou il est 
facile de repérer les éléments propices à être imprimés, ou ceux découpés.

Les éléments plans mais trop épais pour être découpés sont colorés en bleu, 
avec les modules complexes et non décomposables, tels que le système 
d’éclairage zénithal du RDC et les montants des fenêtres. L’étanchéité de ceux-
ci doit être assurée dans la modélisation. Les autres composants destinés à la 
découpe sont colorés en vert. L’élément central du patio, trop épais, est séparé 
en plusieurs parties planes qui seront ajoutées au plan de découpe.

14

15



14

15



15



 3.3 Caractérisation et choix

 Il faut, pour aborder au mieux la modélisation d’un projet, connaître les caractéristiques 
de chaque procédé de prototypage rapide afin d’adapter le mode de conception. Il n’est cepend-
ant pas facile pour l’architecte ou l’étudiant en architecture d’expérimenter ou d’étudier chaque 
procédé, à cause de leur complexité ou de leur disponibilité.

 Pour pallier ce problème pouvant affecter la productivité des étapes d’avant projet, nous 
avons établi un arbre de choix permettant d’orienter l’architecte ou l’étudiant vers l’une ou l’autre 
des techniques disponibles selon la typologie d’éléments qu’il désire soumettre au prototypage 
rapide. Cet arbre s’établit sur trois niveaux de précision et oriente le choix de l’une ou l’autre 
méthode selon la typologie d’élément. Un élément entièrement plan et d’une fine épaisseur, et 
comportant des bords droits sera aisément découpé à l’aide d’une machine à découpe laser. Le 
même élément, comportant des bords biseautés sera beaucoup plus facile à réaliser à l’aide 
d’une imprimante 3D ( sous réserve d’autres facteurs établis dans l’arbre ).

 Le Niveau 0 est très global et signifie la différence entre un type d’élément imprimable 
et un type d’élément que l’on peut découper par laser. Il classifie les éléments architecturaux par 
grand types de morphologie : plan, volume.

 Le Niveau 1 est plus spécifique et adapté aux techniques que l’architecte est plus en-
clin à utiliser, découpe laser, impression 3D, machine à commande numérique, mais aussi la 
maquette d’étude. La classification des éléments se fait plus précise et spécifie par exemple les 
bord des éléments plans, ou encore les cavités dans les volumes.

 Le Niveau 2 est adapté à un étudiant en cinquième année à l’ENSA Nancy, préparant 
son projet de fin d’études. Les techniques dont il dispose sont l’impression 3D, la découpe laser 
et le maquettage traditionnel. L’arbre est adapté aux outils présents et se sert de cette précision 
pour adapter les choix de l’une ou l’autre des solutions. L’impression 3D offrant par exemple 
généralement une qualité de prototypage légèrement meilleure que la découpe laser, introduit 
alors dans l’arbre des choix la composante de qualité désirée. Le Niveau 2 permet, au bout de 
l’arbre, d’avoir deux choix à disposition, et suivant le cas où l’on se trouve, d’avoir accès à leurs 
carastéristiques économiques, temporelles, de finition, et de quantité pouvant être produite.

 Ce système à été testé avec le groupe d’étudiants préparant leur PFE, qui ont fourni 
des modèles à imprimer en 3D pour cette étude. L’étude des caractéristiques de chaque modèle 
proposé avec l’étudiant a permis soit de confirmer la possibilité d’imprimer le modèle, soit de 
soumettre le modèle à des modifications afin de le faire correspondre aux possibilités de la 
technique, ou enfin de déterminer que la technique la mieux adaptée n’était pas l’impression 
3D, et permettre à l’étudiant de poursuivre le prototypage par découpe laser ou maquettage 
traditionnel.
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 3.4 Arbres de choix
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4. Traitement de fichiers

 4.1 Contexte

 L’étude précédente permet d’identifier la meilleure technique de prototypage à utiliser 
selon le modèle. Cependant il arrive qu’un élément requière beaucoup de temps à être réalisé 
par maquettage, et qu’il soit impossible à réaliser par découpe laser. L’impression 3D reste le 
seul mode d’execution disponible pour ces formes complexes. La difficulté réside dans le fait que 
le modèle n’a certainement pas été entièrement pensé et conçu pour être imprimé en 3D.

 L’élément déterminant afin que les techniques de prototypage rapide révèlent au mieux 
leur vitesse se situe lors de la phase de conception. C’est après les premières esquisses, lor-
sque le projet est façonné sur les logiciels CAO qu’il est important d’obéir à quelques règles de 
conception telles que le respecrt de l’étanchéité, et de l’échelle de la machine.

 4.2 Fichiers non adaptés

 Les modèles reçus lors de cette étude, n’étaient pas conçus en vue d’une impression 
3D. La plupart ont dû en grande partie être “réparés” dans des logiciels d’édition 3D. Avant d’être 
slicé, un modèle numérique doit être converti au format  STL ( stéréolithographique ) ou OBJ, ce 
qui signifie être triangulé. La résolution de la triangulation est déterminée dans le module d’ex-
port du logiciel de CAD.

 Lors de la triangulation, les erreurs d’étanchéité du modèle, si elles existent, sont accen-
tuées et le fichier STL généré sera mal interprété par le slicer. Lors des opérations de découpe 
en tranches des fichiers que nous avons traités, la visualisation du gcode montrait des erreurs 
d’interprétation du modèle, résultant de la non étanchéité du modèle, de la présence de doubles 
triangles, ou encore de faces dont la direction ( la normale ) était inversée par rapport aux autres. 

Exemple de triangulation.
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Ces erreurs sont dues à l’exportation STL. Elles peuvent être évitées en veillant à ce que deux 
volumes n’entrent pas en intersection dans le modèle, car le slicer ne peut pas réaliser d’opéra-
tion booléennes, et interprète mal les intersections de volumes si elles ne sont pas réalisées par 
l’utilisateur lui même.

 4.3 Traitement

 Les modélisations défectueuses ont donc été étudiées dans MeshLab qui permet de 
localiser les problèmes des fichiers STL ( aussi appelés Mesh ). Le logiciel NetFabb permet 
ensuite d’éditer le modèle, de fermer les éventuelles ouvertures, de retourner, supprimer des 
triangles etc. Parfois la correction est plus facile à opérer dans le logiciel de modélisation original, 
avant l’export STL. Ces corrections sont généralement rapides à opérer sauf si la quantité de 
modèles est importante.

Repérage des erreurs d’étanchéité sur le logiciel MeshLab

Repérage des erreurs de faces mal orientées dans le logiciel Netfabb
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Réparation des faces mal orientées dans le logiciel Netfabb

Le modèle prêt à être imprimé dans le logiciel MakerWare.

Le modèle imprimé en 3D.



 4.4 Guide

 Lors de l’atelier avec les étudiants de cinquième année, le traîtement des fichiers n’a 
pas été effectué par eux, car nous avions besoin de fichiers bruts pour comprendre les étapes 
nécéssaires à l’adaptation et à la transformation de modèles qui étaient incompatibles avec l’im-
pression 3D.

 Cependant pour des questions de productivité, il est essentiel que les étudiants de 
l’ENSA Nancy sachent préparer leur fichiers eux-même car en réalité il n’y a pas de personnel 
guidant l’utilisateur, et celui ci est livré à lui-même. L’impression de modèle complexes s’avère 
ardue, c’est pourquoi nous avons mis au point un guide permettant d’accompagner l’utilisateur 
dans les opérations de vérification et de réparation de fichiers.

Une maquette de PFE pour laquelle ont été utilisées les techniques d’impression et découpe
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1. Création ou importation du modèle sur SketchUp

- Ou tout autre fichier de modélisation

- Travailler en mm

- Travail de maquette : on modélise à l’échelle 1

2. Vérification + Placement

- Corriger les volumes mal fermés : le modèle doit être étanche

- Procéder à l’intersection de deux volumes qui se rencontrent 
sans se couper

- Séléctionner les éléments puis Clic Droit > Intersection des faces > Avec la sélection

- Centrer le modèle ( l’approcher de l’origine du fichier )

- Accepter les demandes de correction automatiques de SketchUp lors de la sauvegarde
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3. Exportation

- Fichier > Exporter > Modèle 3D > Format OBJ

- Avant de sauvegarder, cliquer sur Options

- Utiliser ces paramètres lors de l’export OBJ

4. MeshLab

- Logiciel gratuit et multiplateforme ( Windows / OS X )

- Se rendre sur meshlab.sourceforge.net et télécharger le logiciel

- Logiciel peu stable pour les opérations avancées

- Mais permet de repérer les failles d’un fichier OBJ

2



5. Repérage

- Importer votre fichier OBJ : File > Import Mesh

- Ouvrir le menu Render > Show Non Manif Edges puis Render > Non Manif Vertices

- Des fenêtres d’analyse s’affichent à gauche

- Si tous les compteurs sont à 0, votre fichier est propre, vous pouvez passer à MakerWare

- Dans le cas contraire, repérer les erreurs sur votre modèle ( signifiées en rose )

3



6. Netfabb

- Logiciel partiellement gratuit et multiplateforme ( Windows / OS X )

- Se rendre sur www.netfabb.com et télécharger le logiciel

- Importer votre fichier OBJ : Project > Add Part

- Les faces colorées en rouge présentent des orientations invalides

- Cliquer sur la croix rouge dans la barre d’outils
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7. Réparation

- Cliquer sur Automatic Repair en bas à droite puis sélectionner Default Repair

- Cette opération clos les ouvertures repérées dans MeshLab et réoriente les faces

- Dans l’encart Status à droite, repérer les champs Border Edge, Invalid Orientation et Holes
 
- Si tous les compteurs sont à 0, votre fichier est réparé

- Si toutes les ouvertures n’ont pas été fermées, cliquer sur Actions en bas à droite puis sur 
Close All Holes

- Si certaines faces sont toujours rouges, les sélectionner manuellement puis Clic Droit > Flip 
Selected Triangles

- Lorsque votre fichier est réparé, cliquer sur Apply Repair en bas à droite puis sur Remove 
Old Part

- Ouvrir le menu Part > Export Part > as STL
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8. MakerWare

- Logiciel gratuit et multiplateforme ( Windows / OS X )

- Se rendre sur www.makerbot.com et télécharger le logiciel

- Importer votre fichier STL : File > Add

- Accepter si le logiciel vous demande Put object on platform?

- Move, Turn, Scale permettent d’apporter des modifications au modèle

9. Exportation

- Cliquer sur le bouton Make

- Choisir la résolution désirée Low - Standard - High

- Cocher Raft, et si votre modèle comporte des éléments en porte à faux, cocher Supports

- Cocher Preview Before Printing puis cliquer sur Export!

- Enregistrer au format X3G pour imprimer, au format Gcode pour l’analyse
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10. Finalisation

- Placer le fichier sur une carte SD pour le transmettre à la machine

- Sur l’écran LCD de l’imprimante, sélectionner Build From SD, puis le nom de votre fichier

- Votre impression est lancée !

- Vous pouvez analyser votre fichier Gcode sur www.gcode.ws

UNTEREINER Thomas



5. Optimisation

 5.1 Expérience

 Plus on imprime, plus on connait les propriétés de la machine. La grande variété de 
modèle imprimés lors de cette étude, des volumes pleins, des surfaces planes biseautées, des 
surfaces bombées, des structures en porte à faux, ont permis d’aquérir de l’expérience quant 
aux particularités de la machine. 

 En faisant des essais d’impression de structure en porte à faux sans “support” ( qui per-
met habituellement de soutenir les élément censés être imprimés “dans le vide” et destiné à être 
enlevé à la main ), il a été observé que ceux- ci ne sont pas toujours nécessaires pour de faibles 
porte à faux, ou de faibles pentes. 

 Le vase Aalto ci dessus a des bords en pente, des suppots auraient normalement dû 
être utilisés, mais celui-ci a été imprimé en haute qualité, ainsi l’impression est plus lente, et les 
porte à faux sont simples à réaliser par la machine puisque la dépose est plus lente et le PLA est 
déja bien sec lorsque la couche suivante est appliquée. 

 La connaissance des particularités de la machine de prototypage rapide, et de son com-
portement selon les différentes  formes imprimées peut être cruciale lors des étapes d’avant 

Vase Aalto imprimé sans support au CRAI
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projet : plus on connait les possibilités de l’outil, plus on peut être productif. A partir d’un certain 
nombre d’impressions, et de typologies de formes différentes imprimées, on commence à visual-
iser lorsqu’on se trouve en possession d’un modèle virtuel, quelle technique de prototypage uti-
liser, de quelle façon l’imprimer, le temps que cette opération va prendre. Par exemple le logiciel 
MakerWare donne une estimation du temps d’impression qui est environ 25% plus importante 
que celle réelle.

 5.2 Ajustement

 Il est parfois nécessaire d’imprimer certains modèles à l’envers ou sur le coté afin qu’ils 
soient mieux interprétés par le Slicer et la machine. Nous avons testé des typologies fines qui ont 
révélé une grande souplesse, on peut ainsi imprimer des fines bandes planes ( 0.4 mm environ ) 
qui peuvent ensuite être tordues, pliées, ce qui permet de gagner un temps de conception et 
d’impression précieux.

  Les objets issus du prototypage rapide par impression 3D sont aussi modifiables facile-
ment après leur réalisation. Le matériau peut être découpé, taillé, poncé, et fondu à l’aide d’un fer 
à souder, afin de corriger d’éventuelles erreurs d’impression ou pour obtenir un rendu plus lisse.

 Le large domaine d’exécution de ces machines requiert un temps d’adaptation et de 
prise de connaissance des possibilités et des limites de l’impression en trois dimensions. Mais 
cette connaissance joue grandement en faveur de la productivité et de l’exploitation totale du 
large domaine d’execution de cette technologie.

Volume complexe sans support; typologie fine et souple
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 5.3 Accessibilité

 Le prototypage rapide, et plus précisément l’impression 3D et la découpe laser devien-
nent de plus en plus accessibles au grand public et aux professionnels. Les machines évoluent 
et coûtent de moins en moins cher, les FabLab ( laboratoires de fabrication ), mettant à dispo-
sition diverses machines de prototypage rapide sont de plus en plus présents dans les grandes 
villes eurpéennes. Il est de plus possible de monter son imprimante soi-même.

 La communauté RepRap ( reprap.org ) propose des plans Open Source ainsi que des 
tutoriels permettant de construire pas à pas sa propre imprimante 3D. Une grande partie des 
pièces de ces imprimantes sont destinées à être imprimées aussi, ce qui signifie qu’une machine 
peut presque en imprimer une autre ( les cartes mère, moteurs, buses d’extrusion etc. doivent 
être commandés à part ).

 Ce procédé encore relativement jeune pourrait parfaitement se développer et convenir à 
l’utilisation par les étudiants de l’ENSA Nancy ou par l’architecte au sein de l’agence. Cette tech-
nique est actuellement en cours de test au CRAI, où nous avons imprimé des pièces en 3D et 
monté une FoldaRap qui, après une longue phase de calibrage et d’ajustement, est maintenant 
utilisable. Il est parfaitement envisageable de voir ce type de technologies équiper l’école, leur 
cout est de l’ordre de 30% d’une imprimante de la société MakerBot, et ces machines peuvent 
servir à en imprimer de nouvelles. Elles nécessitent cependant d’être entretenues plus souvent.

Le FabLab de Nancy ( Image www.bonjournancy.fr )

34



 L’évolution de l’accessibilité de ces machines permettra aux étudiants de faire de plus 
en plus de tests, et de se familiariser avec le technologie d’impression 3D, pour mieux connaitre 
les possibilités de ces machines, et ainsi de pouvoir, dès la phase de conception, savoir que telle 
ou telle pièce de leur maquette pourra ou non être imprimée.

Fichier d’impression et de montage de l’imprimante FoldaRap

L’imprimante FoldaRap du CRAI en cours de calibrage
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6. Conclusion

 Le prototypage rapide comprend des technologies en plein essor mais qui doivent être 
apprivoisées par l’utilisateur, qui en apprenant à connaître leurs caractéristiques, pourra arriver 
à une réelle augmentation de la productivité lors de la réalisation de maquette. Rétroactivement, 
ces maquettes pourront mieux alimenter la conception du projet.

 Cependant il est necessaire de savoir quel type de matériel utiliser, pour quel type de 
modèles et de conceptualiser méthodiquement les éléments du projet en ayant en tête les pos-
sibilités de chaque méthode de prototypage. Le novice pourra, en consultant les arbres de choix 
s’aiguiller en direction de l’une ou l’autre technique afin d’adapter son modèle virtuel dès les 
phases de conception. Le guide sera de plus à sa disposition pour vérifier et réparer ses fichiers 
existants à l’impression 3D et ainsi aider à effacer l’inconnu qu’est l’accès à une nouvelle tech-
nologie. L’acquisition d’expérience est la meilleure façon de fiabiliser cette filière, et cela passe 
par la prise de concience des possibilités de chaque technique, de savoir s’y adapter et d’adapt-
er ses modèles en fonction de la technologie d’impression 3D ou de découpe laser. 

 On développe, au fur et à mesure que l’on imprime des modèles, et cela implique de 
faire des erreurs,  une sorte de clairvoyance et de compréhension de l’outil qui une fois acquise 
sert grandement pour la conception. Le but étant que chacun puisse se dire lors de la conception 
d’un projet : tel élément sera découpé, ceux-ci seront imprimés en 3D, et pendant ces proces-
sus, ces éléments seront réalisés à la main. Cela passe donc par la réalisation par les étudiants 
d’essais successifs qui seront possibles lorsque l’ENSA Nancy sera dotée d’imprimantes 3D 
disponibles pour les étudiants.
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Deux maquettes de PFE pour lequelles ont été utilisées les techniques de découpe, d’impres-
sion 3D, et de maquettage traditionnel
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